Question Paper
Computer Overview

Question 1 Option 1.1

1. Raj finds his computer is very slow when he works with several applications at the same time. What should he do to increase the performance of the computer?
a. Restart the system
b. Increase the amount of RAM
c. Reinstall the operating system
d. Increase the capacity of the hard disk
Question 2 Option 1.2
2. Which one of the following values is equal to 2.5 GB?

a. 2560 TB

b. 3010 TB

c. 2560 MB

d. 3010 MB

Question 3 Option 1.3
3. Which one of the following terms refers to the integration of text, graphics, sound and video?

a. Multimedia

b. E-mail

c. Newsgroup

d. Internet

Question 4 Option 1.4

4. You want to use one of the photographs you took during the last vacation as the wallpaper on the desktop. Which one of the following devices should you use for the purpose?

a. Scanner

b. Web camera

c. Microphone

d. Modem

Question 5 Option 1.5

5. Vinay says that he was watching an entire movie for an hour and a half, from the disk he had hired yesterday. Which one of the following media would have been hired by Vinay?

a. Floppy disk

b. Hard disk

c. DVD

d. RAM

Question 6 Option 1.6

6. Asha wants to take a save a back up of the important data in her computer. The size of the data totals to around 10 MB. She wants to ensure that the backup data is not modified under any circumstances. Which one of the following storage media is the best suited for the purpose?

a. Floppy disks

b. Hard disk of another computer

c. CD-R

d. DVD

Paint

Question 7 Option 2.1

7. Which part of the Paint interface displays a set of buttons that can be used for drawing pictures?

a. Color box

b. Menu bar

c. Status bar

d. Toolbar

Question 11 Option 2.5

8. You have drawn a picture in Paint. When you erase a part of the picture by using the eraser tool, the erased area is filled with green colour. Why did this happen?

a. You selected green from the colour palette before erasing the picture

b. The colour of the picture is green

c. You have set the background colour to green

d. You have set the foreground colour to green

Question 8 Option 2.2

9. Which one of the following tools in the Paint toolbox can be used to draw a freeform line or colour a picture?

a. [image: image1.bmp]
b. [image: image2.bmp]
c. [image: image3.png]



d. [image: image4.bmp]
Question 11 Option 2.5

10. Aarti has drawn a large picture of a farm. She, however, wants to make a change in the drawing that requires her to delete a large area. Which one of the following methods should Aarti use to delete the area quickly?

a. Click the picture and press the Delete key

b. Select the area to be deleted and press the Delete key

c. Click the New command on the File menu

d. Right-click the area to be deleted

Question 8 Option 2.2

11. Which one of the following tools in the Paint toolbox is used to fill an area with a specific colour in just one click of the mouse?
e. [image: image5.png]



f. [image: image6.bmp]
g. [image: image7.bmp]
h. [image: image8.bmp]
Question 7 Option 4.4

12. Tarun is working with several Word documents. Suddenly he finds that Word is not responding. Which one of the following actions should he perform to tackle the unexpected event?

a. Open the Control Panel and use the Add or Remove programs to end the task that is not responding

b. Start Word again

c. Open Windows Task Manager and end the task that is not responding

d. Restart the computer

Question 9 Option 4.6

13.  The steps to change the date are given in a jumbled order.

1.
Under Date, click the month from the list.

2.
Click the required date on the calendar.
3.
In the Date and Time Properties dialog box, click the Date and Time tab.

4.
Click OK to apply the changes and close the dialog box.

5.
Type or select the year in the year box.
Which one of the following options arranges the steps in the correct order?
a. 2(5(3(1(4

b. 3(4(1(5(2

c. 3(2(4(1(5

d. 3(1(5(2(4

Question 6 Option 4.3

14.  Rajeev wants to change his file names to identify them easily. The steps to rename a file are given here in a jumbled order.

1. Right-click the file.

2. Type the new name.

3. Press Enter.

4. Open the folder that contains the files to be renamed.

5. Click Rename.

Which one of the following options arranges the steps in the correct order?

a. 4(1(2(5(3

b. 4(5(3(1(2

c. 4(1(5 (2(3

d. 4(5(1(2(3

Question 4 Option 4.1

15. Bharat wants to view the files and folders as icons along with information on file type and size. From the following list of views, identify the one that Bharat should select.

a. Icons

b. Thumbnails

c. Tiles

d. List

Question 5 Option 4.2

16. Which one of the following commands on the Start menu would you choose to customise the appearance and functionality of your computer?

a. Help and Support

b. My Documents

c. Control Panel

d. My Recent Documents

Question 6 Option 4.3

17. Shazia wants to move a few folders from the D drive to the C drive. The steps to perform the operation are given below in a jumbled sequence.

1. Click CUT on the shortcut menu.

2. Right click the destination folder.

3. Select the folders.

4. Click PASTE on the shortcut menu.

Which one of the following options sequences the steps in the correct order?

a. 3(1(4(2

b. 3(4(2(1

c. 3(1(2(4

d. 2(4(3(1

Question 7 Option 4.4

18. Your system seems to be running slow. You want to see the applications that are currently not responding, using the task manager. Which one of the following key combinations can be used as the first step to invoke the task manager?

e. Ctrl + Shift + Del
f. Alt + Shift + Del
g. Ctrl + Alt + Del
h. Ctrl + Shift + Esc
Question 3 Option 3.1

19. After setting the screen saver, Ajay clicked OK without clicking Apply in the Screen Saver tab of the Display Properties dialog box. What would happen to the changes he has made to the settings?

a. The settings will not be saved

b. The settings will be applied automatically

c. The settings will be saved but the screen saver will not appear

d. The dialog box will prompt to click Apply before clicking OK

Question 3 Option 3.1

20. Priya wants to set her photograph that she has stored in the My Pictures folder as the background for her desktop. The steps to set a background are given in a jumbled order.

1. Click Properties.

2. Right-click anywhere on the blank area of the desktop.

3. Click Apply, and then click OK.

4. Click Browse.

5. Click a picture file in the My Pictures folder, and then click Open.

6. Click the Desktop tab.

Which one of the following options sequences the steps in the correct order?

a. 2(1(6(4(5(3

b. 1(6(4(5(2(3

c. 1(6(4(5(3(2

d. 2(6(1(4(5(3

PowerPoint
Question 12 Option 3.1

21. Rustam, a history teacher, has created a PowerPoint presentation containing ten slides. When Rustam ran the presentation only five slides were shown. What manipulation has Rustam done to the remaining slides in the presentation?

a. Rustam has deleted the slides

b. Rustam had added more content to the other slides that they could not fit the screen

c. Rustam has hidden the other slides

d. He had no content in the other five slides

Question 13 Option 3.2

22. Which one of the following views in PowerPoint displays the text-only version of the entire content of a presentation?

a. Slide

b. Outline

c. Handout

d. Speaker Notes

Question 15 Option 3.4

23. Which one of the following font effects raises the selected text above the normal position and reduces the font size?

a. Superscript

b. Subscript

c. Emboss

d. Shadow

Question 17 Option 3.6

24. Which one of the following views allows you to change the sequence of the slides but not the content?

a. Notes Page View

b. Slide Sorter View

c. Normal View

d. Slide Show View

Question 18 Option 3.7

25. Ajit wants to change the background colour of a slide. The steps to perform the operation are given below in a jumbled order.

1. Click the Background Fill list.

2. Click Apply.

3. Click Background on the Format menu.

4. Click the colour you want.

Which one of the following options sequences the steps in the correct order?

a.
3(4(1(2

b.
1(4(3(2

c. 1(3(4(2

d. 3(1(4(2

Question 20 Option 3.9

26. Whenever Akash decides to change the colour of the text boxes, he has to change for all the 10 text boxes he has inserted in the slide, one by one. Which one of the following options provides the easiest way for him to change the colour for all the text boxes at the same time?

a. Group the text boxes before setting the colour

b. Select all the text boxes each time it has to be formatted and apply the colour

c. Apply colour to one text box and use the format painter to copy the colour to other text boxes each time it has to be formatted

d. Apply colour to one text box and copy and paste the text box four times and change the text each time it has to be formatted

Question 20 Option 3.9

27. Anita is creating a presentation on the theory of speed. Which type of effect should she set to an object to make it move in a specific pattern?

e. Set the motion path to the objects

f. Set the emphasis effect to the objects

g. Set the direction property for the objects

h. Set the speed property for the effects

Question 18 Option 3.7

28. Ravi wants to insert a WordArt object in a slide. The steps to perform the operation are given below in a jumbled order.

1. Select the font, font size and font style you want.

2. Click the WordArt style you want.

3. On the Drawing toolbar, click the Insert WordArt button.

4. Replace the default text with the text you want.

5. Click OK.

              Help Ravi to rearrange the following steps in the correct order.

a. 3(2(1(4(5

b. 3(4(2(1(5

c. 2(3(4(1(5

d. 3(4(1(2(5

Question 19 Option 3.8

29. Suresh is creating a presentation on environment issues. He wants one of the slides to contain a title and a WordArt text object. Which one of the following slide layouts is best suited for the purpose?

a. [image: image9.png]



b. [image: image10.png]



c. [image: image11.png]



d. [image: image12.png]



Question 17 Option 3.6

30. Which one of the following views will you use to display slides in full screen mode?

a. Notes Page View

b. Slide Sorter View

c. Normal View

d. Slide Show View

Question 3 Option 3.1

31. Rashmi is creating a PowerPoint presentation on “Types of Computers”. She wants to change the bullet style of the Option list. The steps to perform this are given here in a jumbled order.
1. Click the required bullet style.

2. Click OK.

3. On the Format menu, click Bullets and Numbering.

4. Select the text or the list.

Which of the following options arranges the steps in the correct order?
a. 4(3(2(1

b. 4(3(1(2

c. 3(4(1(2

d. 3(1(4(2

Question 16 Option 3.5

32. You are running a presentation and want to go back to the previous slide. The mouse stops responding suddenly. Which one of the following keys can you use for the purpose in such a scenario?

a. Down Arrow

b. Spacebar

c. Backspace

d. N

Question 14 Option 3.3
33. Which of the following terms refers to the manner in which text and pictures are arranged on a slide?
a. Layout

b. Placeholder

c. Object

d. Text box

Internet

Question 7 Option 5.1

34. Which one of the following terms denotes the words or pictures in a Web page that help you navigate from one page to another?

a. Hyperlinks

b. Browsers

c. World Wide Web

d. Web addresses

Question 11 Option 5.5

Question 7 Option 5.1

35.    Which one of the following terms refers to viewing and moving through the Web pages?

a. Browsing

b. Chatting

c. Downloading

d. Instant Messaging

Question 8 Option 5.2

36. Your school Principal wants to connect the computers in all the branches of your school in the city. Which one of the following type of networks will suit the purpose?

a. LAN

b. MAN

c. WAN

d. Peer-to-Peer
Question 12 Option 5.6

37.  Which one of the following buttons on the Internet Explorer toolbar will you choose to view the updated cricket scoreboard on a Web site?

a. Search

b. History

c. Favorites

d. Refresh

Question 10 Option 5.4

38. You buy a PC for your personal use at home and you want to have the Internet connection only for a specific duration. Which one of the following types of Internet connections will you opt for?

a. Dial-up Internet connection

b. Dedicated Internet connection

c. Broadband Internet connection

d. Narrowband Internet connection

Question 13 Option 5.7

39. The steps to change the home page are given in a jumbled order.

1. On the General tab, under Home page, click Use Current.

2. Open the Web page you want to set as the home page.

3. On the Tools menu, click Internet Options.

4. Click OK.

Which one of the following options sequences the steps in the correct order?
a. 2(3(1(4

b. 2(4(3(1

c. 1(3(2(4

d. 2(4(1(3

40. Raju is interested in participating in the discussions on science and technology. He wants to know if a Web service can provide him the latest information through e-mail. Which one of the following Web services would you suggest to him?

a. Search Engines

b. E-mail

c. Chat rooms

d. Newsgroups

